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Thank you for your interest in Gravitation3D, an elegant and beautiful program aimed at providing an intuitive understanding of the laws of gravity and having fun.  This documentation will explain the features of Gravitation3D and how to use them.

Getting Started
The Controls
Sample Systems
Tips and Troubleshooting
Getting Started

You can start up Gravitation3D by clicking on the program shortcut or by double clicking any of the sample systems (also reachable by a shortcut in the G3D folder on your desktop).  When first opening a new system, you can see the universe you will be working with.  A reference plane and axes are visible to help orient you as you begin creating systems.
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The fastest way to get cool looking, stable systems on the screen is to open some of the sample systems that are provided.  See the descriptions of these systems here…

Here are a few necessary bits of information to help get you started looking at the sample systems.

Drag Left Mouse

Rotates the view

Drag Right Mouse

Zooms the view

‘A’



Toggles the animation on and off

‘R’



Resets the animation

‘T’



Toggles the controls on and off

Practice getting an intuitive feel for the mouse controls.  It is also fun to zoom way way out and see the entire virtual universe you are working in.

Prerequisites

This program was written with the hopes of staying simple, elegant, and intuitive.  Given the subject matter, at least a basic understanding of physics and mathematics will help you enjoy creating and running simulations more.  Specifically, it helps understanding Newton’s formula for the gravitational force between 2 bodies. 

 But having said that, there are no knowledge prerequisites to be able to run the included sample systems (or the additional downloadable ones on the web).  Since Gravitation3D aims to provide a way to understand gravity intuitively, playing with values to find cool systems can be rewarding without needing a full understanding of the calculations behind them.

The Controls
This section will take a quick look at each of the tabs of Gravitation3D controls.  The controls are accessible from the View menu.  They can also be toggled on and off by pressing ‘T’.

The pages are discussed in order of appearance, though many are quite interrelated.  So you may find some references to later pages in earlier ones.

The Planets Tab
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This page allows you to add and planets to your system and to edit their properties.  The values you enter here represent the starting state of your system.  You will not be able to edit any planet properties after the simulation has started, but must be in the “reset” state.  If the property boxes are grayed out, press ‘R’ to reset (or press the “Reset” button on the Simulation Tab) to allow editing, then make sure you have a planet selected.

Mass, Position, and Velocity are the basic items needed for a simulation.  Position and Velocity are vector values – that is, they have an x, y, and z component.  Use the reference axes and solar plane to help you see these directions.  You need to enter the vector values as comma separated.  For instance, enter 0,0,0 for a center at the origin or 5,0,0 to have a planet offset in the x direction.  Note that if you do not have values formatted correctly, the “Apply” button will remain grayed out.

In addition to entering a value for the starting velocity, you might prefer to let the program attempt to calculate it for you by selecting a planet to orbit (The calculated orbit will start in the XY plane).  Note however, that some planets simply will not orbit others because of differing masses.  If you try to make a sun sized body orbit a moon sized body, for example, you’ll quickly see it won’t work.  Use this feature to help you make smaller massed objects orbit larger ones.  I often use this just as a starting point for velocities.  Since it is more fun to make out of plane orbits anyway, I’ll use this feature to get an idea of what order of magnitude of velocity values to use, then I’ll start experimenting by altering the z component of the velocity.

The Name property will help you identify your planets, but is not necessary.  The Radius, though not important to the simulation, is important to visualize your planets.  To see your planet, you will need a positive radius.

Important Note!!

There is no restriction on units in Gravitation3D, except that the units you use are a “consistent” set.  You will see later that the gravitational constant (G) is editable on the Simulation Tab, so the units of G need to correspond to the units you have here.  I thought it better to provide the flexibility to use any units, though that does come with some responsibility to the user.

Note that the default for the gravitational constant is 1.0 (not the actual value of 6.67259E-11 m^3 kg^-1 s^-2).  This is to make it so the other planet values (masses, radii and such) are much more down to earth.  I find it much more enjoyable to enter values like “10” for masses into my system rather than values like “1.5E+11” (the mass of the earth in kg).  Depending on your value of G, either is perfectly acceptable.

The final 4 planet properties are:

Color:  Allows you to edit the planet color.

Light Source:  Click this if you would like a planet to be a light source. Systems look visually much better if you have at least one of your bodies be a light source.  You’ll see that light sources (suns) actually reflect light off of all the other bodies.  You’ll get cool crescent moons and other effects by making at least one gravitational body a sun.

Locked:  Click this if you would like a object’s position and velocity not to be updated during the simulation.  This is a good way to help you make stable systems.  Just as the sun moves the earth, so does the earth move the sun.  So if you were to create a system with 1 sun and 1 planet that happened to have a net system momentum, you might be surprised to see the whole system tracking off the screen.  Locking planets can help you keep things near the origin.

Ringed:  Allows you to add the visual effect of rings to your planet.

Additional Controls

Highlight:  Since it is not a planet property, you may also choose to “Highlight” the selected planet at any time, even during an animation.  This will magnify the radius of that planet to make it more visual.

Add/Remove:  Add or remove planets from the list.

Apply:  Apply any of the changes to “Edit Box” properties (Name, Mass, Radius, Position, Velocity).  Note that when you change the values of these properties, the Apply button will only be enabled if the entries are well formatted.  In other words, you can’t enter “lots” for the mass.

The Simulation Tab
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This page gives you control over the simulation.  “Simulation Settings” include items that directly affect how the calculation engine will determine the orbits.  The “Animation Controls” options start, stop, and reset the simulation.

Simulation Settings

Reference Newton’s equation for the gravitational force between 2 bodies.

F = G * m1 * m2 / d ^ 2

Gravitational Constant:  “G” in the equation.  The default is given as 1.0 for convenience.

Distance Exponent:  “2” in the equation.

Time Step:  The time (in seconds) between each successive iteration in the simulation.  The default is 0.01 seconds (a value I have found to be a good starting point when G = 1).  1 day (86400 seconds) is a good starting point for true MKS units.  A lower time step is more accurate, but will slow your simulation and may be unnecessary.  A larger time step can easily become unstable.

To help you find a good starting point, there is a button to calculate a default time step.  This calculation makes a best guess at a time step using the value you have for G and certain assumptions about the nature of typical systems.  It is usually enough to get you in the right ball park.

Collision Type:

Elastic - Planets bounce off each other, acting like billiard balls.

Inelastic - Planets stick together, acting like silly putty.

Ghost (Default) - No collisions.  If planets intersect, they will simply move through each other.  The force between planets when intersected is zero however.  This is to reduce the instability that comes with planet centers that come very close to each other.  Note that the theoretical force between 2 planets at the same location is infinite because the distance between them is zero.

Animation Controls

Though the ‘A’ and ‘R’ keys also control starting, stopping, and resetting the simulation, extra buttons are provided here for convenience.

The animation speed is also controllable via a slider. 

Once you have found a stable time step, it is preferable to use the animation speed slider to control the apparent speed of your simulation.  Unlike the time step, this slider does not affect the accuracy of the simulation. 

The Drawing Tab

[image: image5.png]Gray

ion3D Controls

Plets | smiation (57395 | scing | Envrarmert | views | Fun |

~General
I~ show velocity Vectors Anblent Lighting
I~ Show Acceleration Vectors  —4——
I~ wireframe tode

-Trail Cantrols

Trail Type | Draw tral deinton points

© Line  stationary
© pats  To Simulate Hotion

© Hore.

IV Fade Trals

I e ——
Trail iz e
Trall Accuracy





This page gives you control over how the planets are drawn.  It is broken into “General” options and “Trail Controls”.

General

Show Vectors:  Click these to turn velocity and acceleration vectors on or off.

Wireframe Mode:  Planets will not be drawn as solids if this is checked.

Ambient Lighting: Ambient lighting will increase as you move this slider to the right.

Trail Controls

You may select the trails to appear as lines, dots, or not at all.  You may also fade the trails.  One of the coolest effects is drawing the trail definition points to simulate motion.  If this is selected, a dotted trail will appear to follow the planet and will give a sense of motion to the trail.  For this to work however, make sure the trail accuracy slider is not maximized (all the way to the right).  If every trail point is drawn, motion can not be simulated.

Move the Trail Length slider to the right to show more of the trail history.  But note that long trail lengths can make performance suffer.  If trails are faded, the fading effect is spread out over the trail length you set here.

Trail Size can be increased by moving this slider to the right.

Trail accuracy is here for two reasons.  First, by lowering the trail accuracy, you can sometimes improve the performance of the system since fewer points are being drawn.  So it is here as a user controllable optimization.  Second, as trail accuracy decreases and less trail points are drawn, you can get some unique visual effects depending on the other current trail settings.

The Scaling Tab
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This pane is provided to give you control over the scaling of different items.  In realistic scenarios like Our Solar System, the radii are very small compared to the expanse of the system as a whole.  If some artificial scaling were not applied to the radii of the planets, you would never be able to see them!

Scaling issues can also arise depending on the units you choose to use.  Allowing the flexibility of different units means there is a possibility that accelerations and velocities can be a wide range of numbers.  This will help you keep these effects to a reasonable scale on the screen.

For each item, there are 2 ways to scale it. 

(1)  The first slider, “Factor”, is what you would traditionally think of scaling.  As you slide it to the right, the scale goes up in linear proportion to the position of the slider.

(2)  The second slider is a way to enable large variances in values to be brought into a more reasonable range.  When all the way to the left, all items are scaled to their true values.  When all the way to the right, all items have the same value.  As an example, lets say you had 3 planets with radii 1, 2, and 1000.  If the scaling were all the way to the left, you would barely be able to see the first two planets compared to the third.  As you move the slider to the right, you would see all the planets morph towards the same size.  When the slider makes it all the way to the right, all the planets appear the same size (regardless of their radii values).

The Environment Tab
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This page gives you control over the visual effects that surround your system.  It is broken into “General” options and “Solar Plane Controls”.

General

Display Axes/Labels:  These are on by default and give you a visual reference to the coordinate system being used by the program.

Reverse Background Colors:  Makes space white and the stars black.

Star Controls:  Use these to control the number of stars, their distribution, and whether or not they are even displayed.

Solar Plane Controls

Each of these settings can be applied to one of 3 mutually perpendicular solar planes.  You can control whether or not to display the planes, their shape (disk or square), and their size and resolution.

One nice feature about solar planes is that you can warp them to give a visual representation of the gravitational field.  This image is common when explaining the Einstein view of gravity as curved space-time.  The warping effect here is visual only (not a true, accurate, one-over-r-squared depiction).  One reason for this is that the gravity spikes would become infinitely long near the planet centers.  Nevertheless, this effect gives you a feel for the interaction among the different bodies.

Warp scaling is controlled similarly to the other items on the Scaling Tab (I actually would have put it there except for space constraints).  So I would refer you there for a full explanation of the first 2 scaling sliders.  There is an extra slider here however, the “Localization”.  As you move it to the right, the warping effect becomes more localized (spiky).

The Views Tab
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This page gives you more control over how to look at your system.  It can end up putting you right in the middle of it!

The first combo box controls where you are looking at.  By default, this was the origin, but you can also slave the “look at” to any of the planets.  

The second combo box is the “look from”.  By default, this is mouse controlled, but you may also set the view to look from any of the planets.

If the “look from” is slaved, you have two additional options on the “look at”:

(1) to make the look at be mouse controlled or,

(2) to make the look at be the direction of motion of your travel.

The Fun Tab
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Only one item here for Version 1.  Use this slider to control the field of view.  Sliding to the right give you more of the “fish-bowl” effect.

Sample Systems

Here you will find short descriptions of the included sample systems and some of the unique features they demonstrate.  Most all of the systems try to take advantage of standard features that make Gravitation3D elegant, like out-of-plane motion and lighting.  Many systems take advantage of similar features, but I may only highlight that feature in a few of them.

Some recommendations for further investigation are also provided.

Binary
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This ends up being a really pretty system.  It consists of 3 bodies, 2 larger suns rotating about each other and a smaller planet that rotates around the combined mass of the 2 suns. 

Special Features Demonstrated:

· Square Solar Plane

· Fading Trails

Things to try:

· The planet orbit is very cool because it is precessing in multiple axes.  If you let it run for a while and turn the trail length up, you can see the very pretty shape the planet path makes over time.

· Since none of the planets are locked, the whole system has a net positive Z momentum from the small planet.  Note how the planet pulls the suns upward off the solar plane.

· Another very cool thing I found about this system can be seen if you show the acceleration vectors, set the view to look at the planet, then zoom in.  You will see the acceleration vector of the planet pulsing with each rotation of the binary stars.

· Try making a binary of binaries.  Dare I say binary of binary of binaries?

Earth Satellites
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This system shows how small bodies would behave in orbit around our own planet.  The earth was put at the origin and has a true mass in kg.  6 small satellites orbit it in varying paths.  To simulate the sun’s lighting effects (but not gravitational effects!), one of the satellites acts as a light source and has an in plane circular orbit with a period very close to 24 hours.

Special Features Demonstrated:

· Automatic Orbit Calculation

· Environment Controls (no stars)

· Slaved Views

Things to try:

· Want to see what a low earth orbit satellite sees?  Set the “Look From” point to satellite 1 or satellite 4 and set the “Look At” point to the direction of motion.  If you don’t want to get dizzy, you’ll also want to decrease the simulation time step from 60 seconds to something smaller (like 1 second).  You’ll get to see the sunlight rise and fall at a much faster pace than here on earth (1 sunrise and sunset every 90 minutes or so).

Elastic and Inelastic
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The next 2 systems demonstrate one of the fun features of Gravitation3D – collisions.  This system demonstrates elastic collisions (collisions that conserve kinetic energy).  These can be likened to billiard ball collisions.  The next system demonstrates inelastic collisions, which don’t conserve kinetic energy and can be likened to collisions of silly putty.  This first system is quite unstable, the sets of planets making only a few orbits before chaos sets in.

Special Features Demonstrated:

· Elastic collisions

· Changing the Field of View

· Star controls
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This is the inelastic system.  After two planets collide, they stick together, becoming one larger planet with the combined properties of each (mass, volume, center of mass, color).  Though kinetic energy is not conserved when a collision occurs, momentum is conserved.  Note that no planets in this system were given any initial velocities.  So the net momentum of the starting system is 0.  After all the collisions, you can see that momentum was conserved since the final large planet does not move.  This final mega planet has the total mass and volume of the original system and lies at the center of mass of the original system.

Special Features Demonstrated:

· Inelastic collisions

· Reversing the background color

· Wireframe mode

· Ambient lighting control

Locked
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This system shows two visualization tools of Gravitation3D - acceleration/velocity vectors and solar plane warping.  The system consists of two locked suns and one planet.  Watching the planet’s vectors helps understand not only where the planet is headed, but how the forces on it are determining its future direction.  Velocity is colored red, acceleration purple.  

The plane warping helps to visualize the gravity field produced by all the bodies.  Both suns produce a field, as does the planet.  The effect is scaled so that the planet’s gravity is more visually prominent than it actually is.  As the planet moves, you can see how its gravitational influence on the surroundings change.  Collisions are turned off since the system is not at all stable.

Special Features Demonstrated:

· Acceleration and Velocity Vectors

· Solar Plane Warping

· Locked Planets

Moon
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This simple system shows the flower-like path of a sun, earth, and moon system.  The shape of this path actually takes many by surprise.

Special Features Demonstrated:

· Trail motion

· Automatic orbit calculation

Things to try:

· Turn on the acceleration and velocity vector on the drawing pane.  I have set up the scaling so that they should be clearly visible.  It is particularly interesting to watch the moon’s velocity vector.

· The “Draw trail definition points to simulate motion” effect on the Drawing Page is very powerful for elliptical orbits because you can see how the planets speed up as they reach their closest point to the sun.  To demonstrate this, you could delete the moon from this system and lower the initial velocity of the earth (say to 200) to give it a more elliptical orbit.

· Can you get a satellite to orbit the moon (like the Apollo missions)?  This is not easy.  You’ll have to slow down the time step.  Also, think about the relative gravity wells that each body is producing.  It took me a while to get something somewhat stable.  You can download my effort from the web.

· Moons with different orbital planes.  These systems will produce a spiral path as the moon orbits the planet and the planet moves the planet-moon sub system through space.

Negative Mass
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Similar to the locked system, this was a fun endeavor made to show that modeling can sometimes be wilder than the real universe.  The four locked planets in this system all have a negative mass!  Thus they repel rather than attract the small unlocked planet.  The small planet is continually pushed away as it tries to decrease its potential energy.  Solar plane warping helps you visualize the inverse gravitation well produced by the negative masses.

Special Features Demonstrated:

· Acceleration and Velocity Vectors

· Negative Masses

· Solar Plane Warping

Things to try:

· Note that this negative mass system is actually very unstable.  It is only stable in 2 dimensions.  But since we have given no z position values to anything in the system, the numerical calculation will stay stable as is.  You could show the instability by giving any of the planets the slightest z offset for a starting position (try even 1E-6).  So an extension to this system might be to add additional locked planets (with negative mass) to make the system truly stable in all 3 dimensions.

Our Solar System

[image: image17.png]



A must include in the set of sample systems is, of course, our solar system.  This system helps put in perspective the drastic difference between a “year” of the inner planets and a “year” of the outer planets.  

To even be able to see the planets, using radii scaling for this system was a must.  Try returning the scaling to near defaults, and you will have trouble finding any of the bodies, even the sun!

Things to Try:

· Though some might consider this system with mostly circular orbits dull compared to some of the other systems we’ve seen, there are things you can try with a simple system.  Try creating a simple system with constant angular motions – that is with every planet having the same “year”.  You’ll have to compensate for the differing distances from the sun by adjusting the masses of the planets.

Sample Solar System
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This was the system I used to help develop most everything in the program.  The definition has not changed significantly since this project was started, and it was fun for me to watch it evolve.

Tips and Troubleshooting
Tips

Tip:  Try to control the Animation Speed with the slider control, not the time step!

Though the time step has a visual effect on how fast your system evolves, it is better to speed up your simulation with the animation controls.  The reason is that though a larger time step will appear to speed things up, it also makes the calculations less accurate and your system more unstable.

Tip:  Hacking the Definition File

You are encouraged to muck with the saved Gravitation3D files using a text editor!  You will find a few goodies in there.  There are some items not controllable through the UI (planned V2.0 features that are not yet maturely developed) and some items I didn’t want to give the more casual user control over.  The file was designed to be readable.  

There is, of course, no guarantee that Gravitation3D will be able to read your changes or deal with them properly, so you might want to make a backup of any solar system with which you decide to go alter the internals.  There is also no guarantee that everything you see in the definition file currently even does something. 

Troubleshooting

My simulations run sloooooooow!

This program is meant to run on a modern machine with a graphics accelerated video card.  However, some features are more intensive than others and can be changed to improve performance.  Among the items you can change are:

· Trails:  Turning down the Trail Length or Trail Accuracy on the Drawing Tab is one of the best ways to improve speed.  Drawing every simulation point just becomes a lot for the computer to handle.  Trails are one of the main reasons Version 1.0 limits the simulations to 100,000 steps.  Unchecking “Fade Trails” can also help.

· I’ve noticed on my home Pentium III, NVidia TNT2 that the text actually slows things dramatically.  Though you can’t turn off the registration text without registering, turning the axes labels off can help.

· Other things to try

Lower the star count or don’t display stars.

Plane warping is a cool effect, but can be expensive.

Ghost collisions are less intensive than Elastic or Inelastic collisions.

Don’t view in wireframe (surprisingly this is slower than filled mode).

I’ve added planets but can’t see them!

· Make sure all your radii have positive values that are reasonably sized relative to the overall scale of your system.  

· On the scaling page, if you drag the first Radii Scaling slider closer to “uniform”, this should help planets with small radii to come into view.

I can't edit planet values!

· You need to be in the reset state.  Press ‘R’ or push the reset button on the simulations pane.

How come I can’t zoom out with some of the sample systems??

The view may be slaved to a planet, so check this if the mouse doesn’t seem to be helping.

